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MODULE # 01

What does the term "hardware" refer to in the context of computers?
Answer: Hardware refers to the physical elements of a computer.

Name three examples of hardware components in a computer.
Answer: Examples include the keyboard, monitor, and mouse.

What does the term "system unit" encompass?
Answer: The system unit encapsulates the processor, motherboard, CD drives, hard
drives, memory, ports, etc.

Provide three examples of terms related to the system unit.
Answer: Examples include power button, CD ROM, and USB Disk.

What is the purpose of a power button in a computer?
Answer: The power button is used to switch on the computer.

How is a USB Disk described in the paragraph?
Answer: A USB Disk is a small, portable flash memory that plugs into a computer's
USB port.

What is the function of ports and pin sockets in a computer?
Answer: They serve as interfaces that link the computer with peripherals and the
monitor.

What is the role of a USB Port in a computer?
Answer: A USB Port is a point of connection between a computer and other electronic
devices such as a webcam, scanner, printer, mouse, and keyboard.



What does the term "drive bay" refer to?
Answer: Drive bay is a place where hard drives are installed using screws.

What is the primary function of a motherboard in a computer?
Answer: The motherboard holds together the central processing unit (CPU), memory,
and connectors for input and output devices.

What is the processor, and what is its role in a computer?
Answer: The processor is the brain of the computer and is responsible for all
processing tasks.

How is RAM (Random Access Memory) described in the paragraph?
Answer: RAM is random access memory used by the computer system to keep the
running program.

Name two types of interface cards mentioned in the paragraph.
Answer: Sound card and LAN card.

What is the purpose of a fan in a computer?
Answer: The fan is used to cool down the processor to avoid damage.

How is the working process of a computer summarized in the paragraph?
Answer: Data goes into memory as input, undergoes processing, returns to memory,
and is then sent as output or stored.

What is a keyboard, and how is it described in the paragraph?
Answer: A keyboard is an input device used to give the computer input. It is described
as a board with keys installed.

What is a keystroke, and how is it defined in the paragraph?
Answer: A keystroke is a single press of a key on a keyboard.

How many keys are there on a standard keyboard, and what are the two types of
keys mentioned?
Answer: A standard keyboard usually has 104 keys. The two types of keys are
character keys and numeric keys.

What happens when a character key is pressed with the shift key?
Answer: Alphabetic characters become uppercase.

Define the function of numeric keys on a standard keyboard.
Answer: Numeric keys (1 to 9 and 0) are used to enter numbers and become symbols
or punctuation marks when pressed with the shift key.

What are special keys, and give examples mentioned in the paragraph?
Answer: Special keys include Shift, ALT, and Control (Ctrl) keys. Examples are
ctrl+c for copying and shift+character key for printing in capital.



What is the purpose of the Escape key?
Answer: The Escape key is used to escape or exit from certain types of applications.

Name three function keys and provide an example of the function of one of them.
Answer: F1, F2, and F5 are function keys. For example, F5 is used to refresh the web
page in an internet browser.

What does the space bar do, and where is it located on the keyboard?
Answer: The space bar generates space between two characters and is located in the
lowermost row.

What are toggle keys, and name three toggle keys mentioned in the paragraph?
Answer: Toggle keys include Caps lock, Num lock, and Scroll lock. They have
corresponding lights to show their status.

What does the Print screen key do?
Answer: The Print screen key is used to capture all the contents of the screen in a
temporary area.

Define the Insert key and its toggle functionality.
Answer: The Insert key is used to insert or overwrite characters within a word. It acts
as a toggle key.

What are the Home key and End key used for?
Answer: The Home key is used to go to the start of the document, and the End key is
used to go to the end of the document.
What is the purpose of the Page up key and Page down key?

Answer: The Page up key is used to go to the previous page, and the Page down key
is used to go to the next page.
What is the function of the Delete key?
Answer: The Delete key is used to delete characters.

What does the Backspace key do?
Answer: The Backspace key is used to delete the preceding characters.

Define non-typing keys and provide examples mentioned in the paragraph.
Answer: Non-typing keys include Alt, Ctrl, and Shift keys. For example, Alt + F4
closes the active window.

What is the Tab key used for?
Answer: The Tab key is used to put more than one space within characters or words.

Name three other input devices mentioned in the paragraph.
Answer: Microphone, Scanner, Digital camera/Web cam.

What is the purpose of a microphone as an input device?
Answer: A microphone is used to input sound to the computer, commonly used in
motion pictures, radio, and television broadcasting.



What is software, and how is it described in the paragraph?
Answer: Software is a set of instructions that cannot be touched. It gives instructions
to hardware to perform some functionality.

Can hardware function without software?
Answer: No, hardware does not work without software.

What is the term used when a software is updated and a new copy is available in
the market?
Answer: It is called a new version of the software.

Provide examples of different versions of the Windows operating system
mentioned in the paragraph.
Answer: Windows 95 (1995), Windows XP (2001), Windows Vista (2006), Windows
7 (2009), Windows 8 (2012).

How many basic types of computer software are mentioned in the paragraph?
Answer: Three basic types of computer software are mentioned.

Name the two kinds of system software.
Answer: Operating system and Device drivers.

What is the primary function of an operating system?
Answer: Operating systems manage and coordinate the activities of computer
hardware and other software.

How is device drivers compared to a driver of a car in the paragraph?
Answer: Device drivers manage hardware, similar to how a driver of a car is
responsible for action after receiving instructions from the operating system.

What tasks does utility software perform?
Answer: Utility software performs tasks like maintenance, troubleshooting, and virus
scanning.

Provide examples of utility software mentioned in the paragraph.
Answer: Disk scanner and antivirus are examples of utility software.

What type of tasks does application software help with in daily life?
Answer: Application software helps with daily life tasks like calculation, presentation,
and text editing.

What is a word processor, and provide an example mentioned in the paragraph.
Answer: A word processor is a complex form of text editors. An example is MS Word.

How does a spreadsheet software help in accounting and finance work?
Answer: It contains cells (rows and columns) with values, and different formulas can
be applied using default functions. An example is MS Excel.

Which software is used for creating presentations with text, images, or sound?



Answer: MS PowerPoint is used for creating presentations.

What type of company is Microsoft, and name some of its famous software.
Answer: Microsoft is one of the biggest software companies in the world. It has
developed famous software like MS Word, MS Excel, MS PowerPoint, etc.

What are the key points covered in the summary of the lecture?
Answer: The summary covers what software is, the types of software, users,
functionality, and the concept of software versions.

How is a word processor different from a basic text editor?
Answer: A word processor is a complex form of text editors that provides basic
functionality along with features like spell and grammar checkers.

What is the primary function of spreadsheet software?
Answer: Spreadsheet software helps in accounting and finance work by containing
cells with values and allowing the application of different formulas.

Who commonly uses presentation software like MS PowerPoint?
Answer: Business people, educators, students, and trainers commonly use
presentation software like MS PowerPoint.

Which company is mentioned as one of the biggest software companies in the
world in the paragraph?
Answer: Microsoft is mentioned as one of the biggest software companies in the
world.

What is the objective of this lesson?
Answer: The objective is to provide information about computer mice, their functions,
and other pointing devices.

What are devices used to point things at the computer screen called?
Answer: Pointing devices.

Provide examples of pointing devices mentioned in the paragraph.
Answer: Examples include the mouse and trackpad.

How does a mouse work in detecting motion?
Answer: A mouse works by detecting motion relative to its supporting surface.

Are there different types of computer mice available in the market?
Answer: Yes, there are many types of computer mice available in the market, usually
with different shapes or buttons.

How many buttons are there on a standard mouse?
Answer: There are two buttons on a standard mouse - the right mouse button and the
left mouse button.

What is the action of pressing the mouse button one time called?



Answer: Single click.

How is a double-click performed?
Answer: Press the mouse button two times instantly.

Explain the process of dragging an object using a mouse.
Answer: Move the mouse cursor over the object, press and hold the left mouse button,
and move the object to the desired location.

What is a mouse pad used for?
Answer: A mouse pad is a surface used to sense the motion of the mouse.

What does the mouse pointer, arrow, or cursor show on the screen?
Answer: It shows the position and motion of the mouse on the screen.

What is another pointing device mentioned besides the mouse?
Answer: Trackpad (also known as touchpad).

What does a trackpad consist of?
Answer: A trackpad consists of a sensitive surface that translates the motion of a
user's finger to a relative position on the screen.

Describe a trackball as mentioned in the paragraph.
Answer: A trackball is a pointing device with a ball placed in a socket with sensors to
detect the rotation of the ball.

What is the primary function of pointing devices?
Answer: Pointing devices are used to point at things on the computer screen,
facilitating interaction and control.

What is the objective of this lesson?
Answer: The objective is to provide information about computer storage, types of
storage, and commonly used storage devices.

Define storage in the context of computers.
Answer: The process of storing information in a computer is called storage.

What are the devices used to store data called?
Answer: Storage devices.

What are the advantages of storage mentioned in the paragraph?
Answer: Information can be saved in different places in a computer and reused when
needed.

Name the two types of primary storage devices.
Answer: ROM and RAM.

What does ROM stand for, and what type of information does it store?



Answer: ROM stands for read-only memory, and it stores information that can only
be read, not modified, deleted, or removed.

Describe RAM, and why is it considered volatile memory?
Answer: RAM stands for random access memory. It is temporary and volatile
memory because it loses all information when the power is off.

What is the unit for measuring memory, and provide examples of larger units
mentioned.
Answer: The unit is a byte. Examples include kilobyte (KB), megabyte (MB), and
gigabyte (GB).

Why are secondary storage devices needed?
Answer: Secondary storage devices are needed because RAM stores information
temporarily, and ROM cannot store information. They are also non-volatile storage
devices.

Provide examples of secondary storage devices mentioned in the paragraph.
Answer: USB disks, hard disks, compact disks, and magnetic disks.

What are the advantages of secondary storage devices?
Answer: More data can be stored compared to primary storage devices, and
information remains even if the power is switched off.

Name two types of secondary storage devices.
Answer: Magnetic disks and optical disks.

What is a hard disk, and what precautions are mentioned for its usage?
Answer: A hard disk is made of hard material, sealed in casing, and stores data in
circular form. Precautions include avoiding magnets and high-temperature areas.

Why is an optical disk called an optical disk?
Answer: An optical disk is called an optical disk because a laser beam is used to read
and write data.

What are the four types of optical disks mentioned in the paragraph?
Answer: CD ROM, Write once read many (WORM), Re-writeable CDs, and DVDs.

What is the objective of this lesson?
Answer: The objective is to provide information about the security of a computer, the
risks associated with it, and methods of protection against these risks.

Define security risks mentioned in the paragraph.
Answer: Security risks are associated with hardware, software, and data that can cause
significant losses to the owner.

Name two types of risks mentioned in the paragraph.
Answer: Hardware theft and computer virus.



How can hardware theft be prevented?
Answer: Save hardware/computer from stealing by placing it somewhere safe.

What is a computer virus, and how can it damage a computer?
Answer: A computer virus is software that can damage a computer, for example, by
causing it to restart when opening MS Word.

How does antivirus software protect a computer?
Answer: Antivirus software is used to eliminate viruses from a computer. It scans the
hard disk to find and terminate viruses, preventing new ones from entering.

How can unauthorized access to computer data be reduced?
Answer: Protect your computer/data with a password to reduce the risk of
unauthorized access.

Define the term "password" mentioned in the paragraph.
Answer: A password is a unique word that identifies the user and is used to secure
access to the computer/data.

Why is data backup important?
Answer: Data saved in a computer may be lost for various reasons. Having a backup
allows access and use of the data in case of loss or damage.

What is the process of copying data for backup called?
Answer: Backup is the process of copying data.

How can backup utilities help with data organization?
Answer: Backup utilities help organize the data being copied during the backup
process.

Define software piracy.
Answer: Software piracy is when someone copies and sells software without the
permission of the developer or company, which is against software copyright laws.

What is considered one of the biggest problems facing the software industry?
Answer: Software piracy.

What legal action can be taken against those involved in software piracy?
Answer: According to copyright laws, legal action can be taken against those who
steal, copy, or sell software without permission.

What topics were covered in this lesson?
Answer: Hardware security, different types of security risks, computer viruses,
antivirus software, data backup, and software piracy.

What is the objective of this lesson?
Answer: The objective is to provide information about computer output, types of
output, and commonly used output devices.



Define computer output.
Answer: Computer output means taking something out from the computer.

How many types of computer output are mentioned in the paragraph?
Answer: Two types - Soft copy and Hard copy.

Name the forms of output discussed in the paragraph.
Answer: Text, Image, Sound, and Multimedia.

What is the function of a printer as an output device?
Answer: A printer is an output device that prints text or images stored in the computer,
producing a hard copy.

What are the two types of printers mentioned?
Answer: Dot matrix printer and Line printer.

How does a dot matrix printer work?
Answer: It works like a typewriter and consists of pins that create dots, forming
characters and illustrations.

What is the advantage of a line printer over a dot matrix printer?
Answer: A line printer prints a complete line at a time, making it superior in speed
and quality.

What technology is used in a laser printer, and what does it print?
Answer: A laser printer uses the same technology as a photocopier and prints high-
quality graphics. It prints a complete page at a time.

How do inkjet printers create prints?
Answer: Inkjet printers have nozzles that make dots to print, and they are relatively
low in cost.

What is displayed on a computer monitor?
Answer: Whatever is on the screen is called the display, and a monitor outputs the soft
copy of software and programs in the
computer.

Name two types of monitors mentioned in the paragraph.
Answer: CRT monitors (Cathode Ray Tube) and LCD monitors (Liquid Crystal
Display).

What is the advantage of LCD monitors over CRT monitors?
Answer: LCD monitors have advantages in terms of look, lightweight, and compact
size.

What are the common buttons found on a monitor?
Answer: Power button and display adjustment buttons.

What is the purpose of computer speakers?
Answer: Computer speakers output sound, providing audio output for the user.



How do multimedia projectors work?
Answer: Multimedia projectors display both visuals and sound on a screen, working
like a magnifying glass.
Provide an example of a multimedia projector.
Answer: Epson Powerlite 8118 Toshiba Digital Multimedia.

Name a type of computer speaker mentioned in the paragraph.
Answer: Logitech z-640.

What is the term used for the two forms of computer output discussed?
Answer: Soft copy and Hard copy.

Summarize the topics covered in this lesson.
Answer: The lesson covers computer output, types of output (soft copy and hard
copy), and commonly used output devices like printers, monitors, speakers, and
multimedia projectors.

What is the objective of this lesson?
Answer: The objective is to provide information about the internet, services available
over the internet, the World Wide Web, and email.

Define the internet.
Answer: The internet is a network of networks, not belonging to any single entity, and
accessed globally via telephone lines or satellites.

How do users connect to the internet?
Answer: Users connect to the internet through Internet Service Providers (ISPs),
companies or organizations that facilitate the connection.

Name a popular web browser.
Answer: Google Chrome.

What does ISP stand for, and what is its role?
Answer: ISP stands for Internet Service Provider. It connects users to the internet and
is always connected to provide internet access.

List two services available over the internet.
Answer: World Wide Web and Email.

What is the original purpose of the World Wide Web?
Answer: Originally designed for sharing information among the scientific community.

Define a website.
Answer: A website is a collection of related web pages, each with a unique address
known as a Uniform Resource Locator (URL).

How do you access the web?



Answer: Connect to an ISP, open a web browser, enter a URL, and browse the
internet.

What is the advantage of the web?
Answer: The availability of a vast resource of information.

How do you connect to the internet using a telephone line?
Answer: Connect the telephone line to the computer, enter ISP details, including
phone number, username, and password, open a browser, and enter the URL.

What is the purpose of email?
Answer: Email is used for communication between people at a distance, providing
faster and safer delivery than regular mail.

What is an email address?
Answer: An email address is used to send emails from one computer to another, e.g.,
info@vu.edu.pk.

Define an email client.
Answer: An email client is software used to compose, send, receive, or read emails,
allowing access from anywhere in the world with an email ID and password.

Name a famous email client.
Answer: Microsoft Outlook.

MODULE # 02

What do icons represent on the desktop?
Answer: Icons represent programs, files, folders, or other items on the desktop.

How do you move an icon on the desktop?
Answer: To move an icon, click on it, hold the mouse button, drag it to the desired
position, and release the mouse button.

Describe the Recycle Bin.
Answer: The Recycle Bin resembles a waste bin with a recycling logo. It contains
deleted files or folders, allowing users to restore items. Once deleted from the bin,
they cannot be recovered.

How can you delete a file or folder?
Answer: Right-click on the file or folder and choose "delete," drag it to the Recycle
Bin, or select it and press the "Delete" button on the keyboard.

How do you recover files from the Recycle Bin?



Answer: Open the Recycle Bin, click on the file, and then click "Restore this item" on
the toolbar. To restore all items, ensure no files are selected and click "Restore all
items."

What is the path to a file?
Answer: The path to a file is the sequence of drives and folders needed to access the
file. For example, C:\Songs\song1.mp3.

What is the purpose of Windows Explorer?
Answer: Windows Explorer allows users to browse folders and files on the computer,
providing a convenient way to manage and access data.

How do you open Windows Explorer?
Answer: Click on Start > All Programs > Accessories > Windows Explorer.

What are the two parts of the Windows Explorer window?
Answer: List panel on the left side and a detail section on the right side.

How do you resize a window?
Answer: Select the window's bottom right edge and drag it inside or outside without
releasing the mouse.

How can you move a window?
Answer: Click on the title bar of the window and move it without releasing the mouse.

What are the two types of scroll bars in a window?
Answer: Vertical scroll bar (up and down) and horizontal scroll bar (left and right).

How can you identify the active window?
Answer: The active window has a dark-colored title bar, while inactive windows have
light-colored title bars.

How do you close an application window?
Answer: Click the close button (X) or choose "File" and select "Exit."

What areas of the desktop did we learn about in this lesson?
Answer: Basic Desktop Icons, Areas of Desktop, Changing the Size of Window.

How do you create a new folder on the desktop?
Answer: Right-click on the empty area of the desktop and select "New" > "Folder."

What are sub-folders, and why are they created?
Answer: Sub-folders are folders within folders. They are created to organize data in a
structured form.

How can you view the properties of a folder?
Answer: Select the folder, go to the File menu, and click on "Properties."
Alternatively, right-click on the folder and choose "Properties."



What information is available in the General tab of the Properties Panel for a
folder?
Answer: Folder name, type, location, size, number of files and subfolders, creation
date and time, and attributes (read-only, hidden).

How do you rename a folder?
Answer: Right-click on the folder, select "Rename," and enter the new name in place
of the highlighted text.

What is the process to create a new file on the desktop?
Answer: Right-click on the empty area of the desktop, go to "New," and select the
desired file type.

How can you view the properties of a software file?
Answer: Right-click on the file and choose "Properties." The File Properties window
will open.

What information is available in the General tab of the File Properties Panel for
a file?
Answer: File name, type, location, size, creation date and time, and attributes (read-
only, hidden)
.
How do you select multiple files?
Answer: Click near one file and drag around all the files needed, hold down Ctrl key
and select files, or press Shift key to select adjacent icons in a row.

What are the steps to make backup files or folders?
Answer: Copy the file/folder to another secondary storage device, right-click on the
file/folder, and choose "Send To" option or copy and paste into a flash drive.

How do you format a USB drive?
Answer: Right-click on the USB drive icon in My Computer, select "Format," choose
quick format, and click the start button.

How can you search for a file?
Answer: Open My Computer, write the file name in the search bar, and press Enter.

What happens when you format a USB drive?
Answer: Formatting a USB drive removes all data from the drive.

How do you create a new Word document on the desktop?
Answer: Right-click on the desktop, go to "New," and select "MS Word Document."

What is the purpose of the Recycle Bin?
Answer: The Recycle Bin contains deleted files and folders. Files can be restored
from the Recycle Bin, but once deleted from it, they cannot be recovered.

What is the primary function of a printer?



Answer: A printer is hardware that outputs a hardcopy (prints on paper) of a file on a
computer.

What does printer installation involve?
Answer: Printer installation includes hardware installation and software installation.

Describe the steps for hardware installation of a printer.
Answer: Connect the main power cable to the power socket, insert the USB cable into
the USB socket, switch on the main power, and the LED on the printer panel will light
up.

Why does the operating system sometimes fail to install the printer?
Answer: The operating system may not have the required printer software driver.

What is involved in software installation for a printer?
Answer: Insert the CD containing the printer driver into the CD-ROM, click "Next,"
and the computer will copy and install the required driver files, setting it as the default
printer.

How can you initiate printing from an installed printer?
Answer: Open your MS Word file, click on File < Print, and press OK, or press Ctrl +
P to print the document.

What steps are involved in printing in a network environment?
Answer: Open your MS Word file, click on File < Print or press Ctrl + P, choose the
printer name from the printers list, and click Print.

How can you view the print job status?
Answer: Click on Start < Devices and Printers, click on the printer icon representing
the printer you sent prints to, or click the printer icon in the system tray.

What information is displayed in the print job status window?
Answer: Document name, status, owner, pages, size, submitted date/time, and port
information.

What are the alternative methods for initiating printing in MS Word?
Answer: You can click on File < Print.. and press OK or press Ctrl + P to print your
document.

How do you connect the main power cable of a printer?
Answer: Plug the main power cable into the power socket.

What is the purpose of the LED on the printer panel?
Answer: The LED indicates that the printer is powered on.

What is the role of the USB cable in printer hardware installation?
Answer: The USB cable connects the printer to the computer.

How do you choose a printer in a network environment for printing?
Answer: In the Print menu, select the desired printer from the list before clicking Print.



Where can you find information about the print job status in the system?
Answer: Click on Start < Devices and Printers, click on the printer icon, or click the
printer icon in the system tray.

MODULE # 03
What is the objective of this lesson?
Answer: The objective of this lesson is to provide information about adjusting basic
settings of MS Word, inserting various types of data, using the Undo command, and
performing other functions in MS Word.

How can you change the display mode in MS Word?
Answer: You can change the display mode by clicking on the View Ribbon Tab and
selecting the desired layout, such as Print Layout, Full Screen Reading, Web Layout,
Outline, or Draft.

Why might you need to change the zoom level in a document?
Answer: Changing the zoom level allows you to view a document more clearly or see
more than one page at the same time.

What are the methods for changing the zoom level in MS Word?
Answer: You can change the zoom level from the View Ribbon Tab by clicking on
Zoom and selecting the desired level. Alternatively, you can adjust the zoom level
from the bottom right of the document using the + and - signs.

How can you customize the ribbon tabs in MS Word?
Answer: Right-click on the ribbon tabs, select "customize The Ribbon Option," and a
new window will open. In this window, you can check or uncheck tabs to show or
hide them, and you can move tabs up or down to change their position.

Why might you need to change the file format when saving a document?
Answer: Changing the file format is necessary when you want to save a file in a
specific format that can be opened in other software.

What is the purpose of the "Undo" command in MS Word?
Answer: The "Undo" command is used to reverse the last action performed in MS
Word. It can be accessed by clicking the "Undo" button or using the keyboard
shortcut Ctrl + Z.

How can you insert special characters and symbols in MS Word?
Answer: From the Insert tab, click on "Symbol" and select the desired symbol from
the drop-down menu. More symbols and special characters can be accessed by
clicking on "More Symbols."



What operations can be performed using the clipboard in MS Word?
Answer: The clipboard allows you to perform operations such as selecting, cutting,
copying, and pasting text within the document.

How do you select text in MS Word?
Answer: Text can be selected using the mouse left button by pressing and holding it
while moving over the text. Alternatively, the Shift key can be used with arrow keys
or mouse movements to select text.

What is the shortcut key for copying selected text?
Answer: The shortcut key for copying selected text is Ctrl + C.

How do you initiate a search for text in a document in MS Word?
Answer: You can find text in a document by clicking the "Find" button, which is
located in the upper right corner of MS Word, or by using the keyboard shortcut Ctrl
+ F.

What is the purpose of the "Find and Replace" feature in MS Word?

Answer: The "Find and Replace" feature allows you to replace specific words or
phrases in a document with other text.

How can you perform a Find and Replace operation in MS Word?
Answer: Click on "Replace" from the upper right corner, enter the text to find and the
text to replace it with, and click "Replace All" to replace all instances or "Replace" to
replace them one by one.

What is the shortcut key for pasting text in MS Word?
Answer: The shortcut key for pasting text is Ctrl +

What is the objective of this lesson?
Answer: The objective of this lesson is to provide information about adjusting basic
settings of MS Word, inserting various types of data, using the Undo command, and
performing other functions in MS Word.

How can you change the display mode in MS Word?
Answer: You can change the display mode by clicking on the View Ribbon Tab and
selecting the desired layout, such as Print Layout, Full Screen Reading, Web Layout,
Outline, or Draft.

Why might you need to change the zoom level in a document?
Answer: Changing the zoom level allows you to view a document more clearly or see
more than one page at the same time.

What are the methods for changing the zoom level in MS Word?
Answer: You can change the zoom level from the View Ribbon Tab by clicking on
Zoom and selecting the desired level. Alternatively, you can adjust the zoom level
from the bottom right of the document using the + and - signs.

How can you customize the ribbon tabs in MS Word?



Answer: Right-click on the ribbon tabs, select "customize The Ribbon Option," and a
new window will open. In this window, you can check or uncheck tabs to show or
hide them, and you can move tabs up or down to change their position.

Why might you need to change the file format when saving a document?
Answer: Changing the file format is necessary when you want to save a file in a
specific format that can be opened in other software.

What is the purpose of the "Undo" command in MS Word?
Answer: The "Undo" command is used to reverse the last action performed in MS
Word. It can be accessed by clicking the "Undo" button or using the keyboard
shortcut Ctrl + Z.

How can you insert special characters and symbols in MS Word?
Answer: From the Insert tab, click on "Symbol" and select the desired symbol from
the drop-down menu. More symbols and special characters can be accessed by
clicking on "More Symbols."

What operations can be performed using the clipboard in MS Word?
Answer: The clipboard allows you to perform operations such as selecting, cutting,
copying, and pasting text within the document.

How do you select text in MS Word?
Answer: Text can be selected using the mouse left button by pressing and holding it
while moving over the text. Alternatively, the Shift key can be used with arrow keys
or mouse movements to select text.

What is the shortcut key for copying selected text?
Answer: The shortcut key for copying selected text is Ctrl + C.

How do you initiate a search for text in a document in MS Word?
Answer: You can find text in a document by clicking the "Find" button, which is
located in the upper right corner of MS Word, or by using the keyboard shortcut Ctrl
+ F.

What is the purpose of the "Find and Replace" feature in MS Word?
Answer: The "Find and Replace" feature allows you to replace specific words or
phrases in a document with other text.

How can you perform a Find and Replace operation in MS Word?
Answer: Click on "Replace" from the upper right corner, enter the text to find and the
text to replace it with, and click "Replace All" to replace all instances or "Replace" to
replace them one by one.

What is the shortcut key for pasting text in MS Word?
Answer: The shortcut key for pasting text is Ctrl + V.

What is the objective of this lesson?



Answer: The objective is to provide information on changing font size and color,
setting alignment, creating hyperlinks, adding headers and footers, and correcting
spelling mistakes in MS Word.

How can you change the font style in MS Word?
Answer: You can change the font style by selecting the desired font, such as Times
New Roman or Broadway, from the Font segment in the Home Ribbon bar.

What options are available in the Font toolbar?
Answer: The Font toolbar allows you to change the font style, increase or decrease
font size, highlight text, and change text color. It also provides options for making
text bold, italic, or underlined.

What are the shortcut keys for making text bold, italic, or underlined?
Answer: Bold (Ctrl + B), Italic (Ctrl + I), Underlined (Ctrl + U).

How do you add spacing before new lines and between lines in MS Word?
Answer: Pressing the "Enter" button adds spacing before new lines, and adjusting line
spacing is done by pressing the "Line Spacing" button from the Paragraph Tab in the
Home Ribbon bar.

How can you change text colors in MS Word?
Answer: To change text colors, use the Font Tab from the Home Ribbon bar, click on
the "Text Color" button, and select the desired color from the dropdown menu.

What are the alignment options available in MS Word?
Answer: MS Word provides left align (Ctrl + L), center align (Ctrl + E), and right
align (Ctrl + R) options. Justifying text can be done by clicking on the "Justify" button
or using the shortcut key Ctrl + J.

How do you insert a hyperlink in MS Word?
Answer: Select the Insert Ribbon Tab, click on "Hyperlink," and a new window will
open. Enter the link address and text to display. The shortcut key is Ctrl + K.

What is the purpose of the "Borders" feature in MS Word?
Answer: The "Borders" feature allows the insertion of borders to a paragraph or the
entire page. It can be accessed through the Page Layout Ribbon bar.

How do you insert bullets in MS Word?
Answer: In the Home Tab, click on the "Bullets" button in the Paragraph sub-tab to
insert bullets. Different types of bullets, including numeric and alphabetic, are
available.

What are templates in MS Word?
Answer: Templates are pre-designed and styled document samples provided by MS
Word. They can be accessed through the File Ribbon Tab, and users can choose a
suitable template for their needs.

How can you apply multiple styles to a selected text in MS Word?



Answer: Click on the "More Font" button from the Font Tab to open a new window.
Choose multiple styles to apply to the selected text
.
How do you change the page size or setup in MS Word?
Answer: Click on the Page Layout Ribbon Bar, then in the Page Setup, change
margins, orientation, and size of the page according to requirements.

What built-in feature in MS Word helps correct spelling and grammar errors?
Answer: MS Word has a built-in Grammar feature that underlines misspelled words in
red. Right-clicking on the underlined word provides correct spelling suggestions.

What is the purpose of the "Styles and Pagination" feature in MS Word?
Answer: Styles and Pagination allow the application of more than one style to a
selected text simultaneously. This is achieved by clicking on the "More Font" button
from the Font Tab.

What are the objectives of Module 03 on Tables in MS Word?
Answer: The objectives include creating tables, changing column width and height,
inserting and deleting columns and rows, formatting borders, and using images in
documents.

Why do we use tabular data in documents?
Answer: Tabular data, such as time tables, employee contact lists, and product sales
reports, makes it easier for readers to understand information in a structured format.

How can rows and columns be inserted into an existing table?
Answer: Right-click at the desired position, select "Insert" from the options menu, and
then choose whether to insert a row or column to the left, right, below, or above the
current row or column.

How can rows and columns be deleted from an existing table?
Answer: Right-click on the selected row or column, choose "Delete cells" from the
options menu, and select whether to delete the rows or columns along with their data.

How can you change the borders of a table in MS Word?
Answer: Select the table, go to the Design Tab in Table Tools, click on "Borders," and
choose from the drop-down menu. To customize further, click on "Border and
Shading" to open a new window.

Why is styling table borders important in document creation?
Answer: Styling table borders enhances the visual appeal of a document, making it
more professional and engaging for the reader.

What is the significance of the "Border and Shading" option in MS Word tables?
Answer: "Border and Shading" allows users to select the type and color of table
borders, providing customization options based on document requirements.

How do you insert pictures into a document in MS Word?
Answer: There are two main methods: Use the Insert Tab from the Ribbon bar or drag
and drop a picture from a folder directly into MS Word.



How can pictures be resized and rotated in MS Word?
Answer: Click on the inserted picture, then use the mouse to resize or rotate it
according to requirements.

What is the advantage of using pictures in a document?
Answer: Pictures make a document more visually engaging and self-explanatory,
providing additional context to the written content.

What is the purpose of using clip arts in MS Word?
Answer: Clip arts, like pictures, enhance document visuals. They are graphics that can
be inserted using the same method as pictures.

How can you insert clip arts into a document in MS Word?
Answer: Click on "Insert" from the Ribbon bar, select "Online Pictures," and search
for clip arts. Clicking on a clip art will insert it into the document.

Why is tabular data considered useful in document formatting?
Answer: Tabular data provides a structured format that is easier for readers to
comprehend, facilitating better organization and understanding of information.

Which tab is used to access table design options in MS Word?
Answer: The Design Tab from Table Tools is used to access table design options.

How can you search for clip arts online in MS Word?
Answer: Click on "Online Pictures" from the Insert Tab, and a sidebar will open. Use
this sidebar to search for clip arts and insert them into the document.

What is the shortcut key for inserting hyperlinks in MS Word?
Answer: The shortcut key is Ctrl + K for inserting hyperlinks in MS Word.

How can you make text bold, italic, or underlined in MS Word?
Answer: Use the Bold (Ctrl + B), Italic (Ctrl + I), or Underlined (Ctrl + U) buttons
from the Font Tab in the Home Ribbon bar.

Why is it important to change page setup in MS Word?
Answer: Changing page setup allows customization of margins, orientation, and size,
catering to specific printing or document requirements.

How do you correct spelling mistakes in MS Word?
Answer: Right-click on the underlined word, and MS Word will suggest correct
spellings. Click on the correct spelling to replace the error.

What does the "Styles and Pagination" feature allow in MS Word?
Answer: "Styles and Pagination" enable the application of multiple styles to selected
text simultaneously, offering greater flexibility in document formatting.

What are the objectives of Module 03 on Preparing Outputs in Computer
Proficiency License (CS001)?



Answer: The objectives include information on reviewing and proofreading a
document, using a word processor for proofreading, removing spelling and grammar
mistakes, and taking printouts with various options.

Why is it important to review a document thoroughly?
Answer: A document should be checked for layout, information accuracy, spelling,
and grammar mistakes to ensure its overall quality.

What are the elements included in a complete document review?
Answer: A complete document review includes checking page layout, page margins
and numbering, header and footer settings, text and paragraph settings.

How does a word processor help in identifying spelling and grammar mistakes?
Answer: MS Word indicates spelling mistakes with red lines and grammar mistakes
with green lines while writing. It offers a spelling and grammar check feature.

What options are available for correcting spelling and grammar mistakes in MS
Word?
Answer: Two methods: Use the spelling and grammar check feature in the Review tab
or right-click on the word with red or green lines for available correction options.

What is the significance of the green wavy line in MS Word?
Answer: The green wavy line represents a grammatical mistake. It suggests revising
the fragment from a grammar perspective.

How can words not included in the computer dictionary be added?
Answer: Right-click on the highlighted word, and select "Add to Dictionary."

What does a soft copy refer to in the context of document printing?
Answer: A soft copy is a file created using software and saved on a computer.

How can you initiate the printing process in MS Word?
Answer: Go to File < Print or press Ctrl + P, and a dialogue box will open with
various print options.

What are the available options for printouts in MS Word?
Answer: You can select to print all pages, only the current page, or a specific page
range. Multiple copies can also be printed at once.

How can you choose a printer when multiple printers are attached?
Answer: You can select the desired printer from the available options.

What is the purpose of page orientation in printing?
Answer: Page orientation allows you to choose between landscape and portrait
layouts for printing.

What are some available page sizes for printing in MS Word?
Answer: Common page sizes include A4, Letter, and Legal.

How can you set page margins in MS Word for printing?



Answer: You can choose from options like narrow, normal, and others to set page
margins.

What steps can be taken during a document review to ensure accuracy?
Answer: Verify page layout, margins, numbering, header and footer settings, and text
and paragraph settings.

How can you access the spelling and grammar check feature in MS Word?
Answer: Go to the start of the document, click on the Review tab, and then click on
the spelling and grammar check button.

What action should be taken for unfamiliar words to prevent them from being
considered spelling mistakes?
Answer: Right-click on the highlighted word and select "Add to Dictionary" to
prevent it from being considered a mistake in the future.

What is the purpose of selecting page orientation before printing a document?
Answer: Page orientation allows you to choose the layout of the document for
printing, either landscape or portrait.

How can you print multiple copies of a document simultaneously?
Answer: You can specify the number of copies in the print options, and MS Word will
send them to the printer with a single click.

Why is reviewing and proofreading important in document preparation?
Answer: Reviewing and proofreading ensure the document's accuracy,
professionalism, and clarity by identifying and correcting errors before finalizing the
output.

What is the objective of Module 03 on Mail Merge in Computer Proficiency
License (CS001)?
Answer: The objectives include providing information about mail merge, its
importance, the steps involved, creating mailing lists, merging documents, preparing
mailing envelopes, and taking printouts.

Why do we use mail merge?
Answer: Mail merge is used to merge information with letters, preparing them for
delivery, whether as postal mail or electronic mail.

What are the basic steps of mail merge?
Answer: The basic steps involve preparing the letter or invitation, creating a list of
recipients, and merging the information from the list into the main letter.

How can you develop invitations using the mail merge feature?
Answer: Click on the Mailings Tab, start the mail merge wizard, select "Letters" as
the document type, choose to use the current document, and proceed to select or
create a list of recipients.

What is the purpose of the "Insert Merge Field" in mail merge?



Answer: It allows you to insert specific fields, such as names or addresses, into the
letter, ensuring personalized content for each recipient.

How do you edit a data list in mail merge?
Answer: Click on the Mail recipient button in the Mailing tab, a window with the list
will open, select an entry, and click Edit to make changes, add, or delete records.

How can you create mailing envelopes using mail merge?
Answer: Click on the Mailings Tab, select Envelopes, adjust options, select a list,
insert fields, and then print the envelopes.

What are the steps to print merged envelopes for all records?
Answer: Click on "Finish and Merge" in the Mailing tab, choose "Print Documents,"
select "All" in the Merge to Printer window, and click OK to send the print request.

What is the significance of merging information with letters in mail merge?
Answer: It allows for the creation of personalized letters or documents for multiple
recipients with shared content and individualized details.

What type of document could be an example of merged mail?
Answer: An example could be a convocation letter sent to university students, where
the text remains the same, but names and addresses differ.

How do you initiate the mail merge wizard in MS Word?
Answer: Click on Mailings Tab, then Start Mail Merge, and finally, click on the
wizard icon to open the mail merge pane.

How can you create a new mailing list for mail merge?
Answer: Click on "Type a new list" during the mail merge process, and then create a
new list by entering information in the text fields.

What options are available for selecting document types in the mail merge
process?
Answer: Document types can include letters, envelopes, labels, and more, depending
on the desired output.

How can you add new entries or make changes to a mailing list?
Answer: Click on the Mail recipient button, open the list, select an entry, and click
Edit to add, delete, or modify information.

What is the purpose of the "Finish and Merge" button in mail merge?
Answer: It finalizes the merging process and allows you to choose options like
printing documents or sending emails.

How can you print mailing envelopes for specific recipients in mail merge?
Answer: After setting up the envelopes, click on Finish and Merge, choose Print
Documents, select specific recipients, and proceed to print.

Why is mail merge considered useful for handling large emailing tasks?



Answer: Mail merge automates the process of creating personalized documents for a
large number of recipients, saving time and effort.

What role does the "Insert Merge Field" play in creating personalized
documents?
Answer: It enables the insertion of specific fields from the recipient list into the
document, ensuring individualized content.

How can you use mail merge to prepare documents for both postal mail and
electronic mail?
Answer: Mail merge can be used to create documents for either type of delivery,
allowing flexibility in communication methods.

What options are available for selecting recipients in the mail merge process?
Answer: Recipients can be selected from an existing list, a new list can be created, or
recipients can be chosen individually during the process.
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